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1. GETTING STARTED 

1.1 Overview 
 

Welcome to OpenHand.  

OpenHand allows you to dial in to your network remotely via a laptop or PocketPC, to 
access and update your email, calendar, contacts and tasks. OpenHand gives you the 
option of working in real-time, or downloading the information to your device and 
working offline. 
 
If you choose to work in real-time, the information is not stored on the mobile device – it 
is held only on your organisation’s server. This means there is no risk to your 
information if your device is lost or stolen, and that the information is updated in real-
time on your servers. 
 
Alternatively, OpenHand allows you to store emails, calendar items, contacts and tasks 
locally on the device. These files can then be accessed and edited when you are offline 
(they are also accessible when working online), and uploaded when you next connect. 
Unlike synchronisation, which transfers all files, OpenHand allows you to save only the 
required files.   
 
This user guide is aimed at PC users, a separate guide is provided for PocketPC, Palm, 
Clié, Sony Ericsson P800/P900 users. 

 

1.2 Starting OpenHand 

1. Double-click the OpenHand icon.  

2. The OpenHand Main Menu screen is displayed. 

 
  OpenHand Main Menu Screen – Not On-Line 
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1.3 OpenHand Screen Layout and Navigation 
 

From the main window, use the View menu or click one of the following icons on the 
Main Menu:   

  

1.3.1 Main Menu and Toolbar 

  Allows you to read, reply to and create new emails. 

  Shows your calendar and appointments, which you can add and edit. 

  Shows a list of your contacts – from here you can add and edit appointments. 

  Allows you to view, add and edit tasks. 

  Navigate your folders. 

 Log in to OpenHand. 

 Log out from OpenHand. 

 
Tip: Hold your mouse over an icon to see an explanation of its function. 
 

1.3.2 Other Icons 

   Go to a different folder. 

  Create a new item. 

 View the selected item; from here the edit facility is normally available. 

   Delete the selected9 item. 

 Copy selected email(s) to the local mail folder.  

 Recover emails saved in the local drafts folder. 

 Find emails 

 Sort email list 

 Purge emails   

   Edit 

 Refresh the list and show any new items.  

 Attach a file to an email 

 Compose new email  

 Send the email 

 Reply to the sender of the email 

 Reply to sender and all recipients of the email 

 Forward the email to another recipient 
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  Saves a copy of selected folder (mail, calendar, etc.) to local drafts folder 

 Select “To” email recipients  

 Select “Cc” email recipients 

 Select “Bcc” email recipients 

 Find contact 

 Change time interval displayed on your calendar 

 Move list view up one page. 

  Move list view down one page. 

 
1.4 Log in to OpenHand 
 

1. Create an active network connection (see your manufacturer’s hand book for details). 

2. Click on the green arrow on the OpenHand Main Menu to go on line.   

3. The Login Menu will be displayed. 

 
OpenHand Login Screen 

4. Type in your Username for the server you are connecting to. The format depends on 
the type of server: 

For Microsoft Exchange : <DOMAINNAME> \ <USERNAME> 

 

5. Type in your Password for the server you are connecting to: 

For Microsoft Exchange : Use your LAN Account password 

 

N.B. The ‘Connection’ button should only be used when directed by your support 
personnel.  For reference, this shows the ‘IP’ address of the OpenHand server and the 
connection port number.  The Security Key box should never be changed without the 
prior approval of your IT support department. 
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6. Click  in the Login Menu (see 1.4.3 above). 

7. The Main Menu will be displayed.  The connection status arrow and text change to red 
and “Go off line” respectively. 

 
  OpenHand Main Menu Screen – On-Line 

Notes:  

a. To simplify the login procedure you can check the box next to Save Password. The 
device will store both your Username and Password so you will just need to click 
Connect in future. This feature is controlled by your IT manager, if you cannot save 
your password it may be that you do not have permission to do so.  You should 
consider the security implications before using this feature.   

b. If you are unable to log in: 

1. Check your Username and Password are correct and are in the right format for 
the type of server you are connecting to.  

2. Check that Caps Lock is not on. 

3. Click  to check your connection settings. Your network administrator 
will advise you of the correct settings. 

 

1.5 Log out of OpenHand 
 

1. Click on the red arrow in the Main Menu.  This will change to green and the text will 
read, “Go on-line”. 

2. To exit the Main Menu click on File then Exit. 

3. Close your Active Network Connection. 

 

1.6 OpenHand client information 

 

1. Select ‘About…’ from the Main Menu. The version and copyright information will be 
displayed.  Press  to close the ‘About’ box. 
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  OpenHand “About” Screen 
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2.  MAIL 

2.1 View mail 

1. Click  on the Main Menu. 

2. The Mail List is displayed. The screen is divided into the folder list and the emails in 
the current folder, displayed in descending order of date received. Unread emails are 
shown in bold. 

 
 Initial Mail List screen 

Tip: On the Main Menu you can also click View and then click Mail to view your mail. 

 

2.1.1 Access another Email folder 

On the Mail List, click the required folder from the folder list.  N.B. Clicking on the + or – 
next to a folder will expand or contract the folder structure.  Clicking on the folder name 
will list the emails within the folder. 

 

2.1.2 Check for new Emails 

On the Mail List, click  to see new emails. 

 

2.2 Read an Email 
 

1. Click  on the Main Menu. 
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2. On the Folder List, click the required folder. 

3. On the Mail List, double-click the required email, or highlight the email and click . 

Tip:  You can reply to the email by clicking  on the main toolbar, or use  to 
send it on to different recipients.  

 

2.3 Reply to an Email 
 

1. On the Mail List, click the required email. 

2. Click  

3. The reply page is displayed with the sender pre-filled as the recipient and the subject 
pre-filled. 

4. Type in your reply. 

5. Click . 

 

Notes: 

1. You can add additional recipients by specifying their email address in the To, Cc or 

Bcc fields. Either click  to select recipients from your contacts list or type in 

the email addresses separated by a semicolon (;). Click  and  to pick 
up contacts for those fields.  

2. You can click  to add any attachments to the email. This opens a browse window: 
select the directory and double-click on the required file. 

 

2.4 Accepting a Meeting Invitation 
 
1. On the Mail List, click the required email. 

2. Click  

3. The reply page is displayed with the sender pre-filled as the recipient and the subject 
pre-filled. 

4. Below the Subject line is the meeting reply selection box.  Click on the required 
response. 

  

5. Type in your reply. 

6. Click . 
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2.5 Forward an Email 
 

1. Click on the required email. 

2. Click  

3. The Forward Page is displayed with the subject pre-filled. 

4. Enter the recipient(s) of the email in the To field, either by typing their email address 

or by clicking  to select from the Contacts List. Use a semicolon (;) to 
separate recipients. 

5. Enter any recipients in the Cc and Bcc fields either by typing or clicking  and 

 

6. Type in your covering email. 

7. Click  

 

2.6 Create a new Email 
 

1. On the Mail List, click . 

2. The new mail page is displayed. 

3. Enter the recipient(s) of the email in the To field, either by typing their email address 

or by clicking  to select from the Contacts List. Use a semicolon (;) to 
separate recipients. 

4. Enter any recipients in the Cc and Bcc fields either by typing or clicking   and 

 

5. Type in your email. 

6. Click  to add any attachments to the email. This opens a browse window, select the 
directory and double-click on the required file. 

7. Click . 

 

2.7 Delete an Email 
 

All deleted items are moved to the deleted items folder and may be recovered at a later 
stage. 

1. On the email list, click the email(s) to be deleted holding the ‘Ctrl’ key to select 
multiple emails. 

2. Click  

3. Click Yes to confirm. 
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2.8 Purge an Email 
 

When a mail is purged it will be permanently deleted and cannot be recovered. 

1. On the email list, click the email(s) to be purged holding the ‘Ctrl’ key to select 
multiple emails. 

2. Click  

3. Click Yes to confirm. 

 

2.9 Save a local copy of an Email 

1. Highlight the email(s) in the list view, and then click . 

2. An acknowledgement is displayed to confirm that your email(s) have been saved 
locally. 

 

2.9.1 Access a local copy of an Email 

Local copies of Emails are saved in two places, either the Mail or the Drafts sub-folder 
of the Local Storage folder on your device:  

• The Mail folder is where emails are saved when you have simply selected them and 
saved a local copy.  

• The Drafts folder is similar to an “outbox”, storing the emails that have not been 
sent for some reason: 

e.g. If you enter part of an address, OpenHand will attempt to resolve the recipient 
for you. If the email address is not recognised, the email is closed and saved to the 
Drafts sub-folder in the Local Storage folder. 

e.g. If you are working on an email and your connection fails, your email will be 
saved in the Drafts folder.  

1. Click  from the Main Menu, or select the Local Mail sub-folder from the Local 
Storage folder from the email list view. 

2. The screen will refresh and you will see a list of locally stored emails. 

3. On the Mail List, double-click the required email, or highlight the email and click . 

4. You can view an attachment by double clicking on the file icon under the email. 

 

2.10 Printing an Email 

1. Show the email by either double-clicking the email, or highlight it and click . 

2. To print the email, press .  The print dialogue box will be displayed, where upon 
select ‘OK’ to print the email. 
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2.11 Sorting an Email List 
 

To make working with large numbers of emails easier, OpenHand can sort emails by 
either data received or by from or to whom messages were received or sent.  This can 
be in either ascending (A…Z, earliest to most recent) or descending (Z…A, most recent to 
earliest) orders. 

1. On the Mail List page, click on the Sort By criteria. 

2. Select the order the emails are to be displayed by. 

3. The OpenHand server will sort the emails refreshing the mail list page in the order 
selected. 

 Also From and Descending orders. 
Sort by dialogue box 

2.12 Finding Email(s) from within an Email folder 
 

OpenHand’s Find facility refines the Email list to show only emails that meet certain key 
criteria.  These are: 

1. From (Email address) 
2. To (Email address) 
3. Subject heading 
4. Message text (not attachment text) 
5. Read or unread messages 
6. Message received or sent after, before or between selected dates.  

Any combination can be used to further reduce the resulting email list. 

1. On the Mail List page, click on Find.    
      Find button 

2. The Email selection screen will appear. 

 
Selection page 

3. Enter the key words that pertain to the email(s) to be found, and/or select the email 
status. 

4. One or both dates can be used to further narrow the resulting Email list. 

5. Click on OK to start the search or Clear to remove all the criteria data to start afresh. 

The OpenHand server will search for the relevant Email(s) and will display the result in 
the Email list view. 
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3.  CALENDAR 

 
3.1 View Calendar 
 

1. Click the calendar icon  on the Main Menu. 

2. The Calendar Page is displayed showing the currently selected month and the 
schedule for the currently selected date. Days with appointments are shown in bold 
on the monthly view.  

 

 
 Initial Calendar Screen 

 
3.2 Navigating the Calendar 
 

To change the selected date within the currently selected month, simply click on the 
desired date.  This also works for visible dates in the next and previous months.  To 
select a new month or year, click on the month and select the appropriate month and 
year.    To move one month forward or backwards click on the 
appropriate green arrow.  To move to the current date, click on the button near the 
window’s title bar that is labelled with the current date. 
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Month and year selection 

Additional views can be shown in a number of ways.  By clicking on a day, a mini day 
view window is displayed showing that days appointment list. 

 
Pop up day view 

To remove the view click on the X on the top right hand corner of the day view box. 

To view an appointment, double click on the item or select it then press the Detail 

button.   

An alternate day view can be displayed by pressing  which will change the Month 
view to the more detailed Day view. 

 
Day view 

To change the time interval, ‘right’ click in the Day view.  Select the required time 
interval. 

 
Time interval  

Note: Dates are displayed in the short date format specified on your PC. This can be 
changed as follows: 

1. Double-click on My Computer. 

2. Double-click on Control Panel. 

3. Double-click on Regional Options. 
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4. Select the Date tab and change the short date format. 
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3.3 Schedule an Appointment 
 

1. Click  on the Main Menu.  

2. Select the date of the appointment by clicking the required date in the calendar 
window; use the month or year button to change the display, if required (see section 
3.2). 

3. Double-click an empty time slot in the schedule window or click on the start time of 

the appointment and click . 

4. The OpenHand Event page is displayed with the date and start time of the 
appointment pre-filled. 

 
   Selecting a date when creating or editing an event 

5. Fill the title, location and duration of the meeting and any additional information in 
the Text area. 

6. To invite other people to a meeting enter the recipient(s) of the invitation in the To 

field, either by typing their email address or by clicking  to select from the 
Contacts List. Use a semicolon (;) to separate recipients. 

7. Click  to save. 

 
3.4 Schedule a recurring Appointment 
 

1. Click  on the Main Menu.  

2. Select the date of the appointment by clicking the required date in the calendar 
window; use the month or year button to change the display, if required (see section 
3.2). 
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3. Double-click an empty time slot in the schedule window or click on the start time of 

the appointment and click . 

4. The OpenHand Event page is displayed with the date and start time of the 
appointment pre-filled. 

5. Fill the title and duration of the meeting and any additional information in the text 
field. 

6. Click the  icon. 

7. The Event Recurrence page is displayed: 

 
  Appointment recurrence screen – Recurrence not selected 

8. Select the frequency of the meetings from the drop down list. 

9. The pattern section will be refreshed depending on the frequency selected:  Daily, 
Weekly, Monthly, and Yearly. 

 
  Appointment recurrence screen – Weekly recurrence chosen 
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10.Complete the Pattern information and when the recurrence should end.  Putting an 
‘End by’ date is useful for project management. 

11.Click  to save. 

 

3.5 Reschedule an Appointment 
 

1. Click  on the Main Menu.  

2. Select the date of the appointment by clicking the required date in the calendar 
window; use the month or year button to change the display, if required (see section 
3.2). 

3. Double-click on the appointment in the schedule window or click on the appointment 

and click .  

4. The OpenHand Event page is displayed with the existing information pre-filled. 

5. Amend the required information. 

6. Click  to save. 

NB: An appointment can also be dragged and dropped to a new time on the same day. 

 

3.6 Delete an Appointment 
 

Note: If you delete the first occurrence of a recurring appointment all future occurrences 
will be deleted also. 

 

1. Click  on the Main Menu.  

2. Select the date of the appointment by clicking the required date in the calendar 
window; use the month or year button to change the display, if required (see section 
3.2). 

3. Click on the start time of the appointment and click . 

4. Click Yes to confirm when the dialogue box appears. 
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4.  CONTACTS    

 

4.1 Contact List 
 

1. Click  on the Main Menu. 

2. The Contact List page is displayed.  

 
Initial Contact List  Screen (no contacts entered) 

Tip: On the Main Menu you can also click View and then Contacts. 

 

4.1.1 Access another Contacts Folder 

1. On the Contacts List page, click  at the top. 

2. Click on the required folder. 

3. Click OK. 
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4.2 View an existing Contact 
 

1. On the Contacts List page, highlight the required contact. 

2. Click  

3. The Show Contacts page is displayed. 

4. Click  to return to the Contacts List. 

 

4.3 Add a new Contact 

1. On the Contact List toolbar, click  

2. The Add Contact page is displayed. 

 
Add new contact form 

3. Fill in the required information. (Click on the down arrows to populate additional fields 
e.g. to add a mobile number click the down arrow next to Work Telephone and 
select Mobile from the list.) 

4. Click  to save. 

 

Tip: To compose an email to the new contact click  
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4.4 Edit an existing Contact 
 

1. On the Contact List page, double-click on the name of the contact to be displayed (or 

highlight name and click )  

2. The Edit Contact page is displayed. 

3. Edit the required information. 

5. Click  to save. 

 

4.5 Delete a Contact   
 

1. On the Contact List page, right click on the name of the contact to be deleted. 

2. The Edit Menu pop-up is displayed.   

3. Click delete. 

4. A confirmation message is displayed with the name of the contact.  Click ‘Yes’ to 
delete the contact or ‘No’ to return to the contact list. 

 

4.6 Copy a Contact   
 

1. On the Contact List page, right click on the name of the contact to be copied. 

2. The Edit Menu pop-up is displayed.   

3. Click copy. 

4. Right click on the contact again, and then click Paste. 

5. Finally, edit the contact with the new details. 
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4.7 Find a Contact by Name 
 

1. On the Contact List page, in the Input Box, type the name (or part of the name) you 
wish to find. 

 
Entering a name to find a contact by name 

2. Click  

3. A list of contacts is displayed which satisfy the selection criteria. 

Tip: To compose an email to the contact, click on the name and then click  

 

4.8 Find a Contact by Company 
 

1. On the Contact List page, click the down-arrow next to Name to open the drop-down 

list.  

2. Click Company on the drop-down list.  

 
Selecting between finding a contact by name or by company 

3. In the Input Box, type the name of the company you wish to find. 

4. Click  
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5.  TASKS 

5.1 List Tasks 
 

1. Click the task icon  on the standard toolbar.  

2. The Task List is displayed: 

 
Initial Tasks Screen (No tasks entered) 

To change the order of tasks click the down arrow to select the required criteria.  

 

Tip: On the Main Menu you can also click View and then click Tasks to list your tasks. 

 

5.2 View a Task 
 

1. Click  on the Main Menu. 

2. On the Task list, click the required task and click .  
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5.3  Add a new Task 
 

1. On the Task list toolbar, click the Add Icon . 

2. The Add Task page is displayed. 

 

 
Adding a new task form 

3. Put a heading for the task in subject. 

4. Use the downward arrows to select start date, due date, status and priority of the 
task. 

 
Selecting a date when adding or editing a task 

5. Input a description of the task, if required.   

6. Click  to save. 
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5.4 Edit an existing Task 
 

1. On the Task List toolbar, double-click the task, or highlight the task and click . 

2. The Edit Task page is displayed. 

 
Editing an existing task 

3. Change the required information, using the downward arrows to show the drop-down 
lists, where required. 

4. Use the downward arrows to select start date, due date, status and priority of the 
task. 

5. Click  to save. 

 

5.5 Delete a Task   
 

1. On the Task List page, right click on the name of the task to be deleted. 

2. The Edit Menu pop-up is displayed.   

3. Click delete. 

4. A confirmation message is displayed with the name of the contact.  Click ‘Yes’ to 
delete the contact or ‘No’ to return to the task list. 

 

5.6 Copy a Task   
 

1. On the Contact List page, right click on the name of the task to be copied. 

2. The Edit Menu pop-up is displayed.   

3. Click Copy. 

4. Right click on the task again, and then click Paste. 

5. Finally, edit the task with the new details. 
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6.  FOLDERS 

Folders provide another method of navigation.  

 

6.1 List Folders 
 

Click the  icon on the main toolbar. 

Tip: On the Main Menu you can also click View and then click Folders to list your 
folders. 

 

 
Initial Folder  Screen 

To open a folder, click  

To close a folder click  

 

Tip: Use the dropdown list to select folders of a specific type (e.g. mail or contacts 
folders). 

 

6.2 Move to a Folder 
 

1. Click the  icon on the main toolbar. 

2. Double-click on the required folder. 

 

 


